The information in this manual has been checked carefully and is believed to be accurate; however, Opto 22 assumes no responsibility for possible inaccuracies or omissions. Specifications are subject to change without notice.

Opto 22 warrants all of its products to be free from defects in material or workmanship for 30 months from the manufacturing date code. This warranty is limited to the original cost of the unit only and does not cover installation, labor, or any other contingent costs. Opto 22 I/O modules and solid-state relays with date codes of 1/96 or newer are guaranteed for life. This lifetime warranty excludes reed relay, SNAP serial communication modules, SNAP PID modules, and modules that contain mechanical contacts or switches. Opto 22 does not warrant any product, components, or parts not manufactured by Opto 22; for these items, the warranty from the original manufacturer applies. Refer to Opto 22 form 1042 for complete warranty information.

Wired+Wireless controllers and brains are licensed under one or more of the following patents: U.S. Patent No(s). 5282222, RE37802, 6963617; Canadian Patent No. 2064975; European Patent No. 1142245; French Patent No. 1142245; British Patent No. 1142245; Japanese Patent No. 2002535925A; German Patent No. 60011224.


ActiveX, JScript, Microsoft, MS-DOS, VBScript, Visual Basic, Visual C++, Windows, and Windows Vista are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries. Linux is a registered trademark of Linus Torvalds. ARCNET is a registered trademark of Datapoint Corporation. Modbus is a registered trademark of Schneider Electric, licensed to the Modbus Organization, Inc. Wiegand is a registered trademark of Sensor Engineering Corporation. Allen-Bradley, CompactLogix, ControlLogix, MicroLogix, SLC, and RSLogix are either registered trademarks or trademarks of Rockwell Automation. CIP and EtherNet/IP are trademarks of ODVA. Raspberry Pi is a trademark of the Raspberry Pi Foundation. The registered trademark Ignition by Inductive Automation® is owned by Inductive Automation and is registered in the United States and may be pending or registered in other countries.

groov includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org)

All other brand or product names are trademarks or registered trademarks of their respective companies or organizations.

Opto 22
Automation Made Simple.
# Table of Contents

## Chapter 1: Welcome

- Introduction ........................................................................................................... 1
- Ethernet Link Redundancy .................................................................................. 2
- System Architecture ............................................................................................ 2
- Redundancy Option Components ....................................................................... 3
  - SNAP-PAC-SRA Arbiter .................................................................................. 3
  - SNAP-RPSW Redundant Power Switch .............................................................. 4
  - PAC Control Professional and PAC Redundancy Manager ............................. 4
- About this Guide .................................................................................................. 5
- Related Documentation ....................................................................................... 5
- Product Support ................................................................................................. 5

## Chapter 2: Connecting the Hardware

- What You Will Need ............................................................................................. 7
- Configuration Scenarios ....................................................................................... 8
- Connecting the PAC S-series Controllers ............................................................. 9
  - Connecting SNAP-PAC-S2 Controllers ............................................................ 10
  - Connecting SNAP-PAC-S1 Controllers ............................................................ 11
- Wiring the 7-pin Serial Connector on SNAP-PAC-S2 Controllers ...................... 13
- Wiring the 10-pin Serial Connector on SNAP-PAC-S1 Controllers ................. 13
- Wiring the 6-pin Serial Connector on the Arbiter .............................................. 14
- Connecting Power ............................................................................................... 14
- Power Connection Diagram ............................................................................... 15

## Chapter 3: Configuring a Control System

- What You Will Need ............................................................................................. 17
- Assigning a Primary IP Address to ENET 1 on each Controller ...................... 17
- Assigning an IP Address to the Arbiter .............................................................. 21
- Creating a Control Engine for Controller Redundancy .................................... 24
- Commissioning the Controllers for Redundancy ............................................. 26
- Checking the System ........................................................................................ 28
Welcome to the SNAP PAC Redundancy Option User’s Guide. Inside you’ll find instructions on how to set up redundant controllers using two perfectly matched SNAP-PAC-S controllers. This guide assumes that you understand fully how to use PAC Control™ and have some familiarity with Opto 22’s SNAP PAC System™.

**In This Chapter**

- **Introduction**...............................1
- **System Architecture**..................2
- **Redundancy Option Components**.....3
- **About this Guide**.....................5
- **Related Documentation**..............5
- **Product Support**......................5

**Introduction**

While Opto 22 Ethernet-based control systems are extremely reliable, no control system is perfect. However, with properly configured redundant controllers, in the unlikely event that a controller were to fail for whatever reason, a second identically configured controller takes over with almost no down time. The SNAP PAC Redundancy Option provides the tools for developing a control system with an increased level of reliability that can survive single points of failure, and it can improve your system’s mean time between failures (MTBF).

A SNAP PAC System configured with the SNAP PAC Redundancy Option includes:

- Two identically matched S-series PACs
- A SNAP-PAC-SRA arbiter, a hardware device that controls which controller is active based on status information returned by each controller in response to the arbiter’s periodic heartbeat requests. See “SNAP-PAC-SRA Arbiter” on page 3.
- A SNAP-RPSW redundant power switch connected to the arbiter and both controllers. This switch responds to the supply-voltage output from the arbiter, which allows it to reliably restart a controller. See “SNAP-RPSW Redundant Power Switch” on page 4.
NOTE: The SNAP-PAC-SRA arbiter and the SNAP-RPSW redundant power switch can be purchased together in the SNAP PAC Redundancy Option Kit, part number SNAP-PAC-ROK.

- One or more Opto 22 SNAP PAC Ethernet brain-based I/O units on the same Ethernet network as the controllers
- A PAC Control Professional strategy for use on the system’s two redundant controllers that includes special features such as sync blocks and persistent/redundant variables. (See Chapter 4 on page 31.) Included with PAC Control Pro is the PAC Redundancy Manager, a software utility you can use to configure and monitor the redundant PAC S-series controllers and the SNAP-PAC-SRA arbiter.

**Ethernet Link Redundancy**

This guide describes only how to set up redundant controllers for your system, not Ethernet link redundancy, which is also offered by Opto 22. Using PAC Project Professional, Ethernet link redundancy allows you to configure redundant networks for your control system. This is achieved in part by assigning a primary IP address to one Ethernet interface on a PAC S or PAC R controller, and a secondary IP address to the controller’s other Ethernet interface. If communication to the primary address fails, the secondary address takes over.

There are two basic ways to use Ethernet link redundancy:

- **HMI-to-controller link redundancy**, which is not supported when using redundant controllers. For more information, see form 1700, the *PAC Control User’s Guide*, and form 1702, the *PAC Display User’s Guide*.
- **Controller-to-I/O link redundancy**, which is supported when using redundant controllers. For more information, see form 1700, the *PAC Control User’s Guide*.

> NOTE: When using controller-to-I/O link redundancy, you must connect ENET 2 on the controllers and I/O units to a switch. No other devices can be connected to that switch.

**System Architecture**

In the following simplified illustration of the redundancy architecture, two SNAP-PAC-S2 controllers are connected via Ethernet to the same I/O. A SNAP-PAC-SRA arbiter is connected to both controllers with dedicated RS-485 links. An Ethernet crossover cable connected to the ENET 2 Ethernet ports enables communication between the controllers. A SNAP-RSPW redundancy power switch connected to the arbiter controls power to the controllers. Separate power supplies for the arbiter and each of the controllers are not shown.
Redundancy Option Components

The Redundancy Option components—S-series PACs, SNAP-PAC-SRA arbiter, and SNAP-RPSW redundant power switch—are described below.

SNAP-PAC-SRA Arbiter

The SNAP-PAC-SRA arbiter is a stand-alone unit that monitors the operation of the PAC S-series controllers connected to it via a dedicated RS-485 link. If the arbiter detects improper operation of the primary controller, the arbiter switches control to the secondary controller. The SNAP-PAC-SRA arbiter is responsible for:

- Maintains the active/backup status of each controller in a redundant Opto 22 system
- Sends heartbeat requests at regular intervals to each controller in order to receive status information
- Based on the status information, sends messages that make one controller active and put the other controller in backup mode
- Signals the backup controller to qualify itself to be ready to take over as the active controller. The qualification process includes matching the firmware and strategy to those on the active
controller, and updating redundant variables and I/O values. If neither controller is qualified, the arbiter favors controller #1 if both are started up within one second of each other.

- When a controller is disqualified, the arbiter tells the controller to reset itself.
- Manages the power supply of each controller using a supply-voltage output to drive normally-closed relays in the SNAP-RPSW redundant power switch. This allows the arbiter to reliably restart a controller ensuring that I/O never has more than one master.

### SNAP-RPSW Redundant Power Switch

The SNAP-RPSW redundant power switch is a relay device designed especially for use in a SNAP PAC redundant system. Connected to the SNAP-PAC-SRA arbiter and both controllers, this switch responds to the supply-voltage output from the arbiter. This allows a controller to be restarted in order to bring the controller back up, or to re-commission the controller after its firmware has been updated.

### PAC Control Professional and PAC Redundancy Manager

The controllers in a redundant system run a control program built with PAC Control™ Professional, one component of PAC Project™ Professional software. Also included with PAC Project Pro, the PAC Redundancy Manager provides tools to configure the arbiter, monitor the devices in a redundant system, install firmware on the arbiter and the controllers, and more.
About this Guide

Chapter 1: Welcome—Introduces the SNAP PAC Redundancy Option, provides information about this guide, where to find additional information, and how to reach Opto 22 Product Support.

Chapter 2: Connecting the Hardware—Describes how to connect the serial, Ethernet, and power cables for critical devices used in a redundant system.

Chapter 3: Configuring a Control System—Provides instructions on how to use PAC Control, PAC Manager, and the SNAP-PAC Arbiter to configure the controllers and arbiter.

Chapter 4: Creating a Strategy with Controller Redundancy—Describes how to use the Redundancy Option features in PAC Control to create a transactional chart.

Chapter 5: System Maintenance—Describes how to change an IP address on a controller or arbiter, load new firmware, reset the arbiter, use the PAC Redundancy Manager advanced features, and various other system maintenance tasks.

Related Documentation

For more information on topics related to the SNAP PAC Redundancy Option, see the following Opto 22 documents.

<table>
<thead>
<tr>
<th>For this information</th>
<th>See this guide</th>
<th>Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to install and use SNAP PAC S-series controllers</td>
<td>SNAP PAC S-Series Controller User’s Guide</td>
<td>1592</td>
</tr>
<tr>
<td>How to install and use PAC Control</td>
<td>PAC Control User’s Guide</td>
<td>1700</td>
</tr>
<tr>
<td>Detailed information about each command (instruction) available in PAC Control</td>
<td>PAC Control Command Reference</td>
<td>1701</td>
</tr>
</tbody>
</table>

All documents are available on our website, www.opto22.com. The easiest way to find a document is to follow the link above or search on its form number.

Product Support

If you have any questions about using SNAP PAC Redundancy Option, you can call, fax, or email Opto 22 Product Support. Product support is free.

Phone: 800-TEK-OPTO (800-835-6786 toll-free in the U.S. and Canada)
951-695-3080
Monday through Friday, 7 a.m. to 5 p.m. Pacific Time

Fax: 951-695-3017

Email: support@opto22.com

Opto 22 website: www.opto22.com

NOTE: Email messages and phone calls to Opto 22 Product Support are grouped together and answered in the order received.
When calling for technical support, be prepared to provide the following information about your system to the Product Support engineer:

- PC configuration (type of processor, speed, memory, and operating system)
- Software and version being used
- Controller firmware version
- A complete description of your hardware and operating systems, including:
  - switch configuration
  - type of power supply
  - types of I/O units installed
  - third-party devices installed (for example, barcode readers)
- Specific error messages seen.
This chapter describes how to connect the serial, Ethernet, and power cables for the components used in a redundant system, including the SNAP PAC S-series controllers, the SNAP-PAC-SRA arbiter, and the SNAP-RPSW redundant power switch. It also introduces a few basic configuration scenarios.

In This Chapter

What You Will Need .......................................................... 7
Configuration Scenarios ...................................................... 8
Connecting the PAC S-series Controllers ......................... 9
Connecting Power ............................................................... 14

What You Will Need

- A PC running PAC Control Professional 9.0 or higher
- A crossover cable to connect the two controllers.
- 10BASE-T or 100BASE-TX Ethernet network
- The SNAP PAC Redundancy Option Kit, part number SNAP-PAC-ROK, which includes a SNAP-PAC-SRA arbiter and a SNAP-RPSW redundant power switch
- Three SNAP-PS24 power supplies
- A functioning Ethernet-based SNAP PAC control system that includes:
  - Two SNAP PAC S-series controllers that are exactly the same model, such as two SNAP-PAC-S2s or two SNAP-PAC-S2-Ws, with firmware R9.0a or higher and loader R6.0a or higher
  - One or more Opto 22 SNAP PAC Ethernet brain-based I/O units on the same Ethernet network as the controllers
  - PAC Control strategy developed for use on the system’s two redundant controllers. See Chapter 4 on page 31 for information on how to develop a strategy for controller redundancy.
Configuration Scenarios

As shown below there are three basic configuration scenarios. Depending on the level of protection you require at your site, you may want to place the controllers in the same cabinet or in different cabinets. Or you might want to put the arbiter in a different room or cabinet.

Keep the following things in mind when deciding how to configure your system:

- The system will continue to run if any single component fails or in any situation where the currently active controller does not fail and can still communicate to I/O.
- If both the arbiter and the active controller fail simultaneously, or if the active controller fails while the arbiter is already down, the backup will not be able to take over.

**Scenario 1: Controllers and arbiter are in the same cabinet**

**Scenario 2: Controller 1 and Controller 2 are in separate cabinets or rooms, and the arbiter is placed in the same cabinet or room as one of the controllers**

**Scenario 3: Controller 1, Controller 2, and the arbiter are in separate cabinets or rooms**
Connecting the PAC S-series Controllers

As shown here, two SNAP PAC S-series controllers connect to the arbiter using RS-485 serial ports. They connect to each other on ENET 2 with an Ethernet crossover cable. See directions below for either PAC S2s or PAC S1s. See also the diagram on page 2.

*Ethernet connections*

To network

*Serial connections*

Crossover cable

This section includes the following topics:

- “Connecting SNAP-PAC-S2 Controllers” on page 10
- “Connecting SNAP-PAC-S1 Controllers” on page 11
- “Wiring the 7-pin Serial Connector on SNAP-PAC-S2 Controllers” on page 13
- “Wiring the 10-pin Serial Connector on SNAP-PAC-S1 Controllers” on page 13
- “Wiring the 6-pin Serial Connector on the Arbiter” on page 14

For pinouts of SNAP PAC S-series controllers, see form 1592, the *SNAP PAC S-Series User’s Guide*. 

SNAP PAC Redundancy Option User’s Guide
Connecting SNAP-PAC-S2 Controllers

See also “Wiring the 7-pin Serial Connector on SNAP-PAC-S2 Controllers” on page 13 and “Wiring the 6-pin Serial Connector on the Arbiter” on page 14.

1. Using ENET 2 on both controllers, connect the controllers to each other with a crossover cable.

   ![Diagram of ENET connections](image)

   **NOTE:** While not recommended, you can instead use a straight through cable to connect each controller’s ENET 2 to your control network.

2. Using ENET 1, connect the controllers to the network.

3. Connect Serial 2 on Controller 1 to CTR1 on the arbiter using RS-485, “2-wire” mode.


![Diagram of RS-485 connections](image)

**NOTES on RS-485, “2-wire” mode:**
- Correct RS-485 “2-wire” mode requires a single twisted pair for the data wires and an additional insulated wire for the signal common connection.
- It is usually easiest to use a two-pair (shielded) RS-485 data cable, as follows:
  - One pair for data
  - One pair for signal common
  - Shield for chassis ground.
- Do NOT connect the signal common to chassis ground.
Connecting SNAP-PAC-S1 Controllers

See also "Wiring the 10-pin Serial Connector on SNAP-PAC-S1 Controllers" on page 13 and "Wiring the 6-pin Serial Connector on the Arbiter" on page 14.

1. Using ENET 2 on both controllers, connect the controllers to each other with a crossover cable.

2. Using ENET 1, connect the controllers to the network.

3. Connect Serial 2 on Controller 1 to CTR1 on the arbiter using RS-485, "2-wire" mode.

NOTES on RS-485, “2-wire” mode:

- Correct RS-485 “2-wire” mode requires a single twisted pair for the data wires and an additional insulated wire for the signal common connection.
- It is usually easiest to use a two-pair (shielded) RS-485 data cable, as follows:
  - One pair for data
  - One pair for signal common
  - Shield for chassis ground.
- Do NOT connect the signal common to chassis ground.
Wiring the 7-pin Serial Connector on SNAP-PAC-S2 Controllers

Each serial port on the SNAP-PAC-S2 uses a 7-pin pluggable connector supplied with the controller (EBY part number EB1381M-07-500 or equivalent). Use the screws on the side of the connector to insert or remove wires.

CAUTION: Do not use communication port connectors from a legacy OptoControl controller*. Legacy connectors will fit in a SNAP-PAC-S2, but the pin orientation is different. Instead, use the connectors supplied with the SNAP-PAC-S2 controller.

*Legacy OptoControl Controllers

<table>
<thead>
<tr>
<th>G4LC32</th>
<th>G4LC32ISA-LT</th>
<th>M4RTU</th>
</tr>
</thead>
<tbody>
<tr>
<td>G4LC32SX</td>
<td>M4</td>
<td>SNAP-LCM4</td>
</tr>
<tr>
<td>G4LC32ISA</td>
<td>M4IO</td>
<td>SNAP-LCSX/PLUS</td>
</tr>
</tbody>
</table>

Wiring the 10-pin Serial Connector on SNAP-PAC-S1 Controllers

Serial ports 1 and 2 on SNAP-PAC-S1 controllers share a 10-pin pluggable connector (Phoenix Contact, part number FK-MC 0.5 - 2.5, supplied with the controller).

When inserting and removing wire leads into this connector:

1. Completely depress the small orange tab for the appropriate opening with a small screwdriver.
2. While holding the tab down with the screwdriver, insert or remove the wire as needed.
3. Release the orange tab.

Wiring the 6-pin Serial Connector on the Arbiter

The RS-485 serial ports on the SNAP-PAC-SRA arbiter use a 6-pin pluggable connector (Phoenix Contact, part number FK-MC 0,5/06 - 2.5, supplied with the arbiter). When inserting and removing wire leads into this connector:
1. Completely depress the small orange tab for the appropriate opening with a small screwdriver.
2. While holding the tab down with the screwdriver, insert or remove the wire as needed.
3. Release the orange tab.

Connecting Power

Using the Power Connection Diagram on page 15, connect power to the arbiter, controllers, and switch as follows:
1. Connect one of the three SNAP-PS24 power supplies to the SNAP-PAC-SRA arbiter.
2. Connect a power supply to Side 1 of the SNAP-RPSW switch.
3. Connect a power supply to Side 2 of the switch.
4. Connect power from Side 1 on the switch to Controller 1.
5. Connect power from Side 2 on the switch to Controller 2.
6. Connect control wires from the arbiter to Side 1 and Side 2 on the switch.

Now you are ready to configure the redundant system devices. Go the next chapter, Chapter 3: Configuring a Control System.
Power Connection Diagram

red/white wire (+)
black/white wire
This chapter describes how to use PAC Control and the PAC Redundancy Manager to configure the controllers and arbiter.

**In This Chapter**

What You Will Need .......................................................... 17
Assigning a Primary IP Address to ENET 1 on each Controller ................. 17
Assigning an IP Address to the Arbiter ........................................... 21
Creating a Control Engine for Controller Redundancy .......................... 24
Commissioning the Controllers for Redundancy ................................. 26
What You Will Need .................................................................. 28

**What You Will Need**

- Two PAC S-series controllers and the components included with the Redundancy Option Kit connected as described in “2: Connecting the Hardware” on page 7
- PAC Project Professional 9.0 installed on a PC connected to the control network

**Assigning a Primary IP Address to ENET 1 on each Controller**

Each device must have a valid IP address and subnet mask so that it can communicate on the network. If your controllers already have valid primary IP addresses, you can skip to the next section, “Assigning an IP Address to the Arbiter” on page 21.

When you start a SNAP PAC S-series controller that does not have an IP address, it starts in BootP mode, which means it sends out a BootP broadcast requesting an IP address. This is indicated by a quickly blinking status light.

You respond to the BootP broadcast by using the PAC Redundancy Manager or PAC Manager to assign a static IP address and subnet mask. If the network you’re using has a Dynamic Host Configuration Protocol (DHCP) server, either assign a static IP address before connecting the device to the network (preferred), or disable the server. (These servers may respond to BootP requests and assign a dynamic address.)
If the device is not currently in BootP mode, see form 1592, the SNAP PAC S-Series Controllers User’s Guide, to reset the controller.

SNAP PAC S-series controllers each have two separate Ethernet network interfaces; Wired+Wireless models have an additional wireless interface. Each interface has a separate MAC address and therefore takes a separate, unique IP address. However, only ENET 1 sends a BootP request. Once you have assigned the primary IP address to ENET 1, you can assign the secondary address to ENET 2. ENET 1 is used to communicate on the Ethernet network. ENET 2 is used by the controllers to communicate with each other.

**NOTE:** BootP broadcasts cannot get through a firewall in the PC where PAC Manager is running. Make sure any firewall in the computer (such as the built-in firewall in Windows) is disabled before you try to assign IP addresses. Firewalls in a router should not be a problem.

1. Make sure that the Opto 22 hardware is connected according to the instructions in Chapter 2: Connecting the Hardware, and that the PAC Control Pro software is installed on the PC.
2. Make sure you know the MAC address of the S-series controller.
   The MAC address is on a label on the side of the device.
3. Turn on the Opto 22 device(s).
4. On the PC, select Start > Programs > Opto 22 > PAC Project Software > PAC Redundancy Manager.

5. In the Menu area on the left, under Tasks & Tools > General Tools, click Assign IP Address.
   The following dialog box appears. Any Opto 22 Ethernet-based devices without IP addresses that are on the PC’s network segment appear in the list of units requesting IP addresses.
NOTE: If no MAC address appears, check the following:

- Is the controller turned on?
- Is it correctly connected to an Ethernet hub using a straight-through cable? Is the PC on the same subnet as the controller? See the PC’s user’s guide for networking information.
- Does the controller already have an IP address? To change the IP address, see “Changing an IP Address on a Device” on page 52.
- Is the controller booting to the loader rather than the firmware? (See the controller user’s guide.)
- Does the PC have firewall software that blocks network broadcasts? If so, disable the software.

6. Click Select Device next to the MAC address of the controller.

CAUTION: PAC Redundancy Manager lists ALL Opto 22 devices sending BootP or DHCP broadcasts. Assign an IP addresses only to the controller!
ASSIGNING A PRIMARY IP ADDRESS TO ENET 1 ON EACH CONTROLLER

The MAC address appears in the MAC Address text box:

7. Enter the IP Address and the Subnet Mask for the device. Leave the gateway address all zeros, 0.0.0.0. Leave the DNS address at 0.0.0.0 and the Host Name field blank.

   CAUTION: Each device on your network, including computers, routers, controllers, brains, and so on, must have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network or hardware failures. If you don’t know which IP addresses are safe to use, check with your system administrator.

8. When the IP address, subnet mask, and other fields are correct, click Assign IP Address. Progress is shown at the bottom of the screen.

9. When all items user Progress are checked, click Done.

10. Repeat steps 5 through 9 for Controller 2.
Now you are ready to assign an IP address to the arbiter as described in the next section.

Assigning an IP Address to the Arbiter

**NOTE:** This section details how to assign an IP address to the arbiter for the first time. If your arbiter already has an IP address and you want to change it, see “Changing an IP Address on a Device” on page 52.

Each arbiter ships from the factory with a unique hardware Media Access Control (MAC) address and with a default IP address of 0.0.0.0, which is invalid. The arbiter must have a valid IP address and subnet mask so that it can communicate on the network. You can do this using either PAC Manager or the PAC Redundancy Manager. The following instructions are for the PAC Redundancy Manager.

**NOTE:** In order to assign IP addresses, you must be logged in with administrative rights.

When you start a SNAP-PAC-SRA arbiter that does not have an IP address, it starts in BootP mode, which means it sends out a BootP broadcast requesting an IP address. This is indicated by a quickly blinking status light.

If the device is not currently in BootP mode, see “Resetting the Arbiter” on page 62 to restore factory default settings.

**NOTE:** BootP broadcasts cannot get through a firewall in the PC where PAC Manager is running. Make sure any firewall in the computer (such as the built-in firewall in Windows) is disabled before you try to assign IP addresses. Firewalls in a router should not be a problem.

You respond to the BootP broadcast by using the PAC Redundancy Manager or PAC Manager to assign a static IP address and subnet mask. If the network you’re using has a Dynamic Host Configuration Protocol (DHCP) server, either assign a static IP address before connecting the device to the network (preferred), or disable the server. (These servers may respond to BootP requests and assign a dynamic address.)

**NOTE:** To make sure the arbiter is not on a network with a DHCP server, we recommend you use a crossover cable with a direct connection to assign IP addresses. If you connect directly to a PC that is normally on a DHCP network, be aware that you must assign a fixed IP address to the PC’s network card (NIC) in order to communicate.

1. Make sure that the Opto 22 hardware is connected according to the instructions in Chapter 2: Connecting the Hardware, and that the PAC Control Pro software is installed on the PC.
2. Make sure you know the MAC address of the SNAP-PAC-SRA arbiter. The MAC address is on a label on the side of the device.

3. Turn on the SNAP-PAC-SRA arbiter.

4. On the PC, select Start > Programs > Opto 22 > PAC Project Software > PAC Redundancy Manager.

   The PAC Redundancy Manager opens.

5. In the Menu area, click Assign IP Address.

   The following dialog box appears. Any Opto 22 Ethernet-based devices without IP addresses that are on the PC’s network segment appear in the list of units requesting IP addresses.

NOTE: If no MAC address appears, check the following:

- Is the arbiter turned on?
- Is it correctly connected to the PC using a crossover cable or correctly connected to an Ethernet hub using a straight-through cable? Is the PC on the same subnet as the arbiter? See the PC’s user’s guide for networking information.
- Does the arbiter already have an IP address? To change the IP address, see “Changing an IP Address on a Device” on page 52.
- Does the PC have firewall software that blocks network broadcasts? If so, disable the software.

6. Click Select Device next to the MAC address of the arbiter.

   CAUTION: PAC Manager lists ALL Opto 22 devices sending BootP or DHCP broadcasts. Assign an IP addresses only to the arbiter!
The MAC address appears in the MAC Address text box:

7. Enter the IP Address and the Subnet Mask for the device. Leave the gateway address all zeros (0.0.0.0). Leave the DNS address at 0.0.0.0 and the Host Name field blank.

CAUTION: Each device on your network, including computers, routers, controllers, brains, and so on, must have a unique IP address. Failure to assign unique IP addresses may cause catastrophic network or hardware failures. If you don’t know which IP addresses are safe to use, check with your system administrator.

8. When the IP address, subnet mask, and other fields are correct, click Assign IP Address. Progress is shown at the bottom of the screen.

9. When all items under Progress are checked, click Done.
Now you are ready to create a redundant control engine to use in your strategy, as described in the next section.

Creating a Control Engine for Controller Redundancy

The instructions below describe how to create a control engine to use with a redundant controller system. These instructions are for PAC Redundancy Manager. You can also create a control engine using PAC Control. For basic information on how to define a control engine, see form 1700, the PAC Control User’s Guide and “Configuring an Existing Control Engine for Redundancy” on page 37 of this guide.

1. Make sure you have connected the hardware as described in Chapter 2: Connecting the Hardware.

2. Make sure you have completed all of the procedures in the previous sections of this chapter.

3. In PAC Redundancy Manager, under Redundant Control Engines, click “Edit list with PAC Terminal” to open PAC Terminal.

4. In the PAC Terminal window, under Configure Control Engines, click Add to open the Control Engine Configuration dialog box.

5. Enter a descriptive name for the control engine.

   Valid characters are letters, numbers, spaces, and most other characters except colons and square brackets. Spaces cannot be used as first or last characters.

6. Under System Type, select Redundant Controllers.

   New Settings options appear.

   Add
7. Using the IP addresses you created earlier, enter the IP address for Controller 1, Controller 2, and the Arbiter, then click OK.

For information on assigning IP addresses, see “Assigning a Primary IP Address to ENET 1 on each Controller” on page 17 and “Assigning an IP Address to the Arbiter” on page 21.

The completed dialog box will look something like this:

```
7. Using the IP addresses you created earlier, enter the IP address for Controller 1, Controller 2, and the Arbiter, then click OK.
   For information on assigning IP addresses, see “Assigning a Primary IP Address to ENET 1 on each Controller” on page 17 and “Assigning an IP Address to the Arbiter” on page 21.
   The completed dialog box will look something like this:

8. For Controller Port, Software Retries, and Software Timeout, use the default settings:
   Controller Port: 22001
   Software Retries: 0
   Software Timeout: 5000 msec

9. Click OK, and then exit PAC Terminal.

10. In PAC Redundancy Manager, under Redundant Control Engines, click Refresh.
    The control engine you created with redundant controllers appears under Redundant Control Engines.
```
COMMISSIONING THE CONTROLLERS FOR REDUNDANCY

Additional configuration options are described in “Using Controller Redundancy – Debug Options” on page 60.
Now you are ready to commission the controllers for redundancy as described in the next section.

Commissioning the Controllers for Redundancy

SNAP PAC S-series controllers have two independent Ethernet network interfaces, labeled on the top of the controller as ENET 1 and ENET 2. The controller sends its initial BootP request from ENET 1, and the IP address you assign to the controller is for this primary interface.

The two PAC S controllers in a redundant system communicate with each other using the secondary IP address over ENET 2. In order to assign the secondary address, you must first assign the primary address. See “Assigning a Primary IP Address to ENET 1 on each Controller” on page 17.

When assigning the secondary addresses for ENET 2 on each controller, make sure that the secondary address for Controller 1 is even, such as 172.22.22.2; make sure the secondary address for Controller 2 is odd, such as 172.22.22.3. Also, the two IP addresses must be sequential, such as the examples, 172.22.22.2 and 172.22.22.3.

To assign the secondary IP for ENET 2, follow the steps below.

NOTE: If you need to configure or modify settings for the network interface cards on your PC, you must be logged in with administrative rights.

1. Make sure that Controller 1 and Controller 2 are both connected according to the instructions in Chapter 2: Connecting the Hardware, and that both controllers are turned on.
2. Make sure that the PAC Project software is installed on the PC.
3. Make sure that you have assigned a primary IP address to ENET 1 for both Controller 1 and Controller 2, and that you know these addresses. For more information, see “Assigning a Primary IP Address to ENET 1 on each Controller” on page 17.
4. Make sure that you have created a redundant control engine that uses the IP addresses of the controllers and arbiter that you want to commission. See page 24.

NOTE: The following instructions are for PAC Redundancy Manager. However, you can use PAC Terminal to commission the controllers for redundancy.

5. In PAC Redundancy Manager, under Tasks & Tools > Controller Management, click Commission for Redundancy.
6. Select Controller 1, and click “read the current settings” to see if the controller is already set up for redundancy. If it is, skip to step 8.

**NOTE:** If the PAC Redundancy Manager cannot find the address, you will receive an error message. If you receive an error message, check the following:

- Did you enter the IP address correctly when you created the control engine?
- Is the controller turned on?
- Is the controller correctly connected to an Ethernet hub using a straight-through cable? Is the PC on the same subnet as the controller? See the PC’s user’s guide for networking information.

7. Enter a secondary IP address and subnet for ENET 2 of Controller 1.

The ENET 2 port is used to connect the controllers to each other. The recommended settings for ENET 2 for Controller 1 are as follows:

- Secondary IP Address: 172.22.22.2
- Subnet Mask: 255.255.255.240

**NOTE:** Make sure the secondary address for Controller 1 is even, such as 172.22.22.2. And, make sure the secondary address for Controller 2 is odd, such as 172.22.22.3. In addition, the two IP addresses must be sequential, such as 172.22.22.2 and 172.22.22.3.

8. Select Controller 2 and repeat the steps above for the second controller.

The recommended settings for ENET 2 for Controller 2 are as follows:

- Secondary IP Address: 172.22.22.3
- Subnet Mask: 255.255.255.240

9. When all the secondary IP address fields are correct, click Apply Settings.
The information is sent to the SNAP PACs.

10. Note the progress as the settings are applied, the device reset, and the process is completed.

11. Click Done at the bottom of the dialog box.

Now you are ready to add the configured and commissioned system to a strategy. See the next chapter, Chapter 4: Creating a Strategy with Controller Redundancy.

Checking the System

Use System Checkout in PAC Redundancy Manager to confirm that your system is configured and connected correctly.

CAUTION: Be careful if you use this feature on a system that is currently running a process. During the system check, the first PAC is checked and the second PAC’s strategy is cleared; then the strategy from the first PAC is copied to the second PAC, and the second PAC is checked.

A green check indicates that a test was passed successfully. A red X indicates that a problem was found.

2. If a problem is detected, follow the on-screen directions to correct the problem. (Remember that a strategy must be running on the controller in order for the check to work.)

3. Click System Checkout again.

If your system is properly configured, the results screen looks like this:

Now you are ready to create a strategy designed for controller redundancy. See the next chapter, Chapter 4: Creating a Strategy with Controller Redundancy
This chapter describes how to set up a PAC Control Pro strategy for controller redundancy. Redundant controllers are configured identically. This means that they are programmed with the same strategy, they run in lockstep with each other, and their variables and I/O have the same values. The Active controller is in charge and informs the Backup controller of its state. This is achieved by the Active controller telling the Backup controller every time it changes a variable, I/O, or moves to the next instruction or flowchart block. PAC Control provides extra control for the strategy programmer to reduce the communication overhead of synchronization; only persistent/redundant variables and I/O are synchronized, and by using sync blocks, synchronization is delayed until a sync block is encountered in a transactional chart.

In This Chapter

Glossary of Terms .................................................................31
Creating a Redundant Strategy .................................................33
  Step 1. Enabling the PAC Control Redundancy Features .............33
  Step 2. Adding a Redundant Control Engine to a PAC Control Strategy ....33
  Step 3. Configuring Persistent/Redundant Data .........................39
  Step 4. Designing a Transactional Chart .....................................41

Glossary of Terms

Persistent/Redundant Data
Data generated by persistent/redundant variables that are replicated to an available backup controller whenever synchronization occurs. See Chapter 4: Creating a Strategy with Controller Redundancy.

Redundant Control Engine
Sequential Programming
The method of programming used in a PAC Control chart. A sequentially programmed chart starts at one block and proceeds sequentially through command blocks to the end using variables, inputs, and outputs.

Sync Block
A block type in PAC Control used only for redundant strategies. When a sync block is encountered in a chart, the data generated by the chart is synchronized in both the active and backup controllers. The sync block also indicates to the backup controller what state the chart is in (running/stopped/paused) and where in the logic to begin in case the active controller fails. A chart that uses sync blocks is called a transactional chart (see the glossary entry below).

When a sync block is placed in a chart, this tells the controller not to do any writes (in that chart) to any I/O or persistent/redundant variables until it encounters a sync block. All the various kinds of writes that occur in a chart after a sync block are not executed until the next sync block is encountered. In this way both controllers know what points/variables have been written to.

For more information, see “What Causes Synchronization to Occur” on page 45.

Transaction
While the term “transaction,” is borrowed from the transactional database world, for our purposes, a transaction is a collection of redundant operations that are logged and deferred until a sync block is encountered, at which point the data generated by a transactional chart is synchronized in both the active and backup controllers. Each transaction starts with the first write of a persistent/redundant variable or I/O, and it ends with a sync block.

Transactional Chart
A special PAC Control chart used to support persistent/redundant data with redundant controllers. A transactional chart always includes at least one sync block, which is used to define a transaction (see
Creating a Redundant Strategy

When you create a strategy for controller redundancy, most tasks such as configuring I/O, programming with commands, using PID loops and so on are exactly the same as for a non-redundant strategy. (See form 1700, the PAC Control User’s Guide, for more information on creating a strategy in PAC Control.)

What makes a redundant strategy different is:

1. A redundant control engine
2. Persistent/redundant variables
3. One or more transactional charts, which use sync blocks to organize logic into transactions

In order to create a strategy to run on redundant controllers, you must first configure persistent/redundant variables that you want to be replicated to the backup controller. Then you create transactional charts, using sync blocks to indicate where in the logic you want the synchronizations to occur.

Creating a PAC Control strategy for controller redundancy includes the following tasks.

“Step 1. Enabling the PAC Control Redundancy Features” on page 33.
“Step 2. Adding a Redundant Control Engine to a PAC Control Strategy” on page 36.
“Step 3. Configuring Persistent/Redundant Data” on page 39.
“Step 4. Designing a Transactional Chart” on page 41.

Step 1. Enabling the PAC Control Redundancy Features

When redundancy is enabled for a strategy, the following features become available:

- The **Sync Block icon** appears in the toolbar. If you do not see the sync block icon, click in the logic area of a chart to make it appear. For information on using sync blocks in a strategy, see Chapter 4: Creating a Strategy with Controller Redundancy.

- **PAC Redundancy Manager** can be accessed within PAC Control for control engines configured for controller redundancy. You can also access PAC Redundancy Manager from the Start menu: select Start > Programs > Opto 22 > PAC Project Software > PAC Redundancy Manager. For instructions on using Redundancy Manager, see “Step 2. Adding a Redundant Control Engine to a PAC Control Strategy” on page 36 and sections in Chapter 3 and Chapter 5.
The Persistent/Redundant option becomes available on the Add/Edit Variable dialog box. Redundant variables are persistent variables that are replicated to a backup controller when one is available. For more information, see Chapter 4: Creating a Strategy with Controller Redundancy.
CHAPTER 4: CREATING A STRATEGY WITH CONTROLLER REDUNDANCY

- **Controller Redundancy - Debug Options** become available in a pop-up menu for control engines configured for redundant controllers. For more information, see “Using Controller Redundancy – Debug Options” on page 60.

To enable the redundancy features in PAC Control:

1. Start PAC Control by clicking the Start button and selecting Programs > Opto 22 > PAC Project > PAC Control Pro.
   
The PAC Control main window opens.

2. Click the Open Strategy button on the toolbar, or select File > Open Strategy.

3. In the Open Strategy dialog box, navigate to the strategy you will use for the redundant system, and then open it.

4. Select File > Strategy Options, and then click the Redundancy tab.

5. Click the text highlighted in blue: “Enable controller redundancy support.”
   
When enabled, the Strategy Options dialog box looks like this:
6. Click the Download tab.
7. In the Flash Memory section, make sure that both of these options are checked:
   - Save strategy to flash memory after download
   - Set autorun flag after download
8. Click OK.

Step 2. Adding a Redundant Control Engine to a PAC Control Strategy

In order to access PAC Redundancy Manager from within PAC Control, or to create a strategy to control a system with controller redundancy, you must first add a control engine to your strategy that is configured for redundant controllers. You can either add to your strategy the control engine you created in Chapter 3 (see “Creating a Control Engine for Controller Redundancy” on page 24), or you can configure a control engine from within PAC Control.

Adding an Existing Redundant Control Engine

If you’ve already created a control engine for redundancy (page 24), add it to your strategy using these steps. If you need to modify a control engine for redundant controllers, see the next section, “Configuring an Existing Control Engine for Redundancy” on page 37.

1. Make sure you have connected the hardware and configured a redundant system as described in the two previous chapters.
2. With a strategy open in PAC Control in Configure mode or Online mode, choose Configure > Control Engine.
In the Configure Control Engines dialog box, the redundant control engine’s name appears in the list.

3. Check to make sure the correct control engine appears in the Active Engine field. If not, highlight the one you want and click Set Active.

Only one control engine can be active at any time. If only one control engine is listed, it automatically becomes the Active Engine.

**Configuring an Existing Control Engine for Redundancy**

Use the following procedure to configure an existing control engine with redundant controllers.

1. Start PAC Control and open your strategy in Configure mode or Online mode.

Define a control engine for your strategy as described in form 1700, the *PAC Control User’s Guide*.

2. Double-click your control engine on the Strategy Tree to open the Configure Control Engines dialog box.
3. Click Modify.
   The Select Control Engine dialog box appears.

This dialog box lists all the control engines configured on your system, whether or not they are associated with your strategy.

4. Highlight the control engine’s name and then click Modify.
   The Control Engine Configuration dialog box appears.

5. Under System Type, select Redundant Controllers.
   New Settings options appear.

6. Using the IP addresses you created earlier, enter the IP address for Controller 1, Controller 2, and the Arbiter, then click OK.

   **NOTE:** These are the addresses you configured previously for the controllers and arbiter. See “Assigning a Primary IP Address to ENET 1 on each Controller” on page 17 and “Assigning an IP Address to the Arbiter” on page 21.
7. For Controller Port, Software Retries, and Software Timeout, use the default settings:
   - Controller Port: 22001
   - Software Retries: 0
   - Software Timeout: 5000 msec

8. Click OK.

9. In the Select Control Engine dialog box, make sure the correct control engine is highlighted, and then click OK.

10. Click OK again to close the Configure Control Engines dialog box.

---

### Step 3. Configuring Persistent/Redundant Data

Redundant variables (labeled as Persistent/Redundant in PAC Control) are persistent variables that are replicated to an available backup controller whenever synchronization occurs. For optimal performance of your redundant system, best practice is to always use transactional charts. Also, keep in mind to use redundant variables only as necessary. Because each additional redundant variable must be synchronized, too many can increase system overhead and slow down the system.

All redundant variables (as well as I/O changes) are synchronized no matter where the change is initiated, either in a running chart or when using Debug Mode in PAC Control. I/O changes include setting outputs, starting pulsing, and so on.

When a redundant variable that resides in a transactional chart is changed, the value on that controller changes immediately, but it is not synchronized until the next sync block is encountered. When a redundant variable resides in a non-transactional chart (a chart without sync blocks), the
variable is synchronized immediately after it is changed, and this can cause your system to slow down.

To create a persistent/redundant variable, see "Configuring Redundant Variables" on page 40.

**Persistent/Redundant Variables**

Most variables can be persistent/redundant. However, pointer variables, pointer tables, and timers can be redundant but not persistent. Normally, variables are set to an initial value (which you specify during configuration) either whenever the strategy is run or whenever it is downloaded. Persistent/redundant variables, however, are initialized only when the strategy is first downloaded. Persistent variables are initialized with zero until set for the first time, after which the value does not change unless the strategy or other client changes it. The variable’s value is saved in the controller’s memory; it does not change when the strategy is run, stopped, or started, and it does not change if the strategy is changed and downloaded again.

A persistent/redundant variable’s value remains the same until one of the following events occurs:

- The value is changed with PAC Control Debugger or other client.
- A strategy with a different name is downloaded.
- The RAM memory on the controller is cleared.
- New firmware is downloaded to the controller.
- The persistent/redundant object is changed as follows:
  - A persistent/redundant table’s length (integer, 64-bit integer, float, and string) is modified.
  - A persistent/redundant string variable’s length is modified.
  - A persistent/redundant string table element’s string length is modified.
  - A persistent/redundant variable’s type is changed. For example, a persistent/redundant float variable is deleted and a new persistent/redundant integer variable is created with the same name.
- The strategy writes a new value to the variable.

**Configuring Redundant Variables**

To add a redundant variable:

*NOTE: These are basic instructions only. For more information on configuring variables, see Chapter 9: Using Variables and Commands in form 1700, the PAC Control User’s Guide.*

1. Make sure that redundancy is enabled for the strategy. See page 33.
2. With the strategy or subroutine open in Configure mode, choose Configure > Variables.
The Configure Variables dialog box opens.

3. In the Type drop-down list, choose the type of variable you want to configure.
4. If you are adding the variable to a subroutine, select Subroutine in the Scope drop-down list.
5. Click Add.

The Add Variable dialog box appears.

6. Name the variable, select the type, and under Initialization, select Persistent/Redundant.
7. Click OK.

The Add Variable dialog box closes and the new variable appears in the Configure Variables dialog box.

Step 4. Designing a Transactional Chart

NOTE: Before you begin, make sure to enable the redundancy features in PAC Control. (See page 33.)

This section describes the basics of how to design a transactional chart, a special PAC Control chart that you must use if your strategy is used to support persistent/redundant data with redundant controllers. You create a transactional chart simply by adding sync blocks at strategic places in a PAC.
Control chart’s logic. A transactional chart is usually sequential; it starts at one block and proceeds sequentially through command blocks to the end using variables, inputs, and outputs.

A transactional chart’s logic is organized as a series of transactions, a term borrowed from the transactional database world. For our purposes, a transaction is a collection of redundant operations that are logged and deferred until a sync block is encountered, at which point the data generated by a transactional chart is synchronized in both the active and backup controllers. Each transaction starts with the first write of a persistent/redundant variable or I/O, and it ends with a sync block.

If the active controller fails, the sync block also indicates to the backup controller what state the chart is in (running/stopped/paused) and where in the logic to begin. In this case, the backup controller takes over as the active controller.
The chart restarts on the new active controller beginning with the closest sync block previous to the failure point.

**Transaction Example**

In this example of a transactional chart, a cookie baking process is implemented on redundant controllers using sequential programming. As shown in the illustration, the highlighted transaction starts when the conveyor is stopped. It continues by turning on the oven and the bake timer. The transaction ends at the next sync block.

Using a redundant bake timer variable maintains the proper baking time. If a long delay were used instead to control bake time, a restart to the previous sync block would result in the delay occurring twice and the cookies would burn. Short delays can be used to facilitate the efficient execution of a strategy. However, longer delays should not be used in a transactional chart.

**Design Considerations and Chart Constraints**

Consider the following guidelines when designing a redundant control strategy:

- Use persistent/redundant variables only as necessary. Because each additional persistent/redundant variable must be synchronized, too many persistent/redundant variables can increase system overhead and slow down the system.
• Construct logic using sequential programming. See “Transaction Example” on page 43.
• Do not use long delays.

When developing a transactional chart, keep the following constraints in mind:
• Counters cannot be cleared.
• Latches are unavailable (but a counter can be used in place of a latch by storing and comparing count values).
• Min/Max clearing is not supported, so Min/Max functionality is not useful.
• The following commands are not supported in redundant strategies:
  – Call Chart
  – Clear All Latches
  – Clear Counter
  – Clear Off-Latch
  – Clear On-Latch
  – Continue Calling Chart
  – Get & Clear Analog Maximum Value
  – Get & Clear Analog Minimum Value
  – Get & Clear Counter
  – Get & Clear Off-Latch
  – Get & Clear On-Latch
  – Get Off-Latch
  – Get On-Latch
  – IVAL Set Off-Latch
  – IVAL Set On-Latch
• Subroutines may not contain sync blocks. However, a subroutine may perform operations on redundant objects.
• Called charts are not supported. (Call Chart is not supported, but Start Chart is.)
• You cannot do background downloads. However, PAC Redundancy Manager allows you to download to the non-active controller and then quickly switch over to it.

Using Reads and Timers

Reads can occur at any time. Reading an analog channel, for example, occurs the moment the command is executed in the chart. The same is true when reading any kind of variable or change to I/O.

Timers are similar to redundant variables in that if you start a timer, it does not start in the other controller until a sync block is encountered; starting a timer is a write operation. Once started and synced, the timer is activated in both controllers. Each controller can read from that timer without requiring a sync block or synchronization to occur. However, stopping a timer requires a sync block to be encountered to stop the timer on both controllers.
What Causes Synchronization to Occur

A synchronize operation is performed whenever a sync block is encountered in a transactional chart. A sync operation is also performed for the following reasons:

- Changes occur in non-transactional charts (without sync blocks) to persistent/redundant variables and I/O.

  NOTE: Changing redundant variables and I/O in non-transactional charts can cause your system to slow down significantly because without sync block, the controllers are synchronized each time a persistent/redundant variable changes. Therefore, in charts with persistent/redundant variables, whenever possible use sync blocks to control when the controllers are synchronized.

- An operator changes a value for a persistent/redundant variable in PAC Control Debug mode or in PAC Display Runtime. Only the changed persistent/redundant variable is synchronized. In Runtime, if an operator changes a tag that is linked to a persistent/redundant variable, the changed variable is synchronized immediately.

Adding a Sync Block

A sync block is added to a chart in the same way that other PAC Control blocks are added (an action or condition block, for example). For more information on adding a block and using it in a chart’s logic, see form 1700, the PAC Control User’s Guide.

1. Make sure that redundancy is enabled for the strategy. See “Step 1. Enabling the PAC Control Redundancy Features” on page 33.

2. With the chart open and the strategy in Configure or Online mode, click the Sync block tool.

3. Move the mouse into the window, and notice an outline representing the block.
4. Click where you want to place the block. The new block appears.
5. Click in another location to place other blocks of the same type.
6. When you have finished using the tool, click the right mouse button, click another tool in the toolbar, or press ESC.

To use sync blocks in a chart’s logic, you’ll need to name the block, and connect it to other blocks in the chart. You can also change the size of the block, its color, and the font. For more information, see form 1700, the *PAC Control User’s Guide*. 
5: System Maintenance

This chapter describes how to change an IP address on a controller or arbiter, load new firmware, reset the arbiter, use the PAC Redundancy Manager advanced features, and various other system maintenance tasks.

In This Chapter

Checking System Status ................................................................. 47
Changing an IP Address on a Device ........................................... 52
Installing New Firmware .............................................................. 53
Managing Memory ....................................................................... 56
Using Advanced Functions ........................................................... 58
Using Controller Redundancy – Debug Options ......................... 60
Arbiter Status LEDs and Blink Codes .......................................... 61
Resetting the Arbiter .................................................................. 62

Checking System Status

When you have completed your strategy and it is running on the controller, you can check the status of the arbiter and both of the controllers using System Overview in PAC Redundancy Manager.

1. Make sure you have a fully configured redundant system, and your strategy is downloaded and running on your redundant system.

   For more information about downloading and running a strategy, see form 1700, the PAC Control User’s Guide.
2. In PAC Redundancy Manager, under Tasks & Tools > System Management, click System Overview.

The System Overview screen displays basic device information, such as IP address, type of device, and the strategy running on the controllers. It also displays status messages which you can use to troubleshoot your system. See the sections below, “Redundant System Status Messages” and “Redundant System State Machine.”

**Redundant System Status Messages**

The System Overview screen in PAC Redundancy Manager displays status messages about the state of the arbiter and the controllers. You can use this information to address problems with your system. For additional help, also see the next section, “Redundant System State Machine.”
Status messages for the arbiter include Connected, Trying to connect, and Not connected. Status messages for the controllers include:

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The controller has a strategy and is able to run it. The strategy may or may not be running at the moment.</td>
</tr>
<tr>
<td>Active (I/O Impaired)</td>
<td>The controller has a strategy and is able to run it. However, one or more I/O units failed to respond to the controller's communication request within the allowed time. You should verify that all I/O units are online. If that doesn't resolve the issue, you can increase the arbiter's loop time by setting its value in the memory map (arbiter MMP address 0xF8000104). The default value is 50 milliseconds (00000032 hex) and the maximum value is 250 milliseconds (000000FA hex).</td>
</tr>
<tr>
<td>Cold Start</td>
<td>The controller is changing to active. This is usually a very short state.</td>
</tr>
<tr>
<td>Failed</td>
<td>The controller is not responding to the arbiter. It may be off, or disconnected, or have firmware or hardware issues.</td>
</tr>
<tr>
<td>Failed (Possibly Active)</td>
<td>The controller is not responding to the arbiter. Its last known state was Active, and it may still be running its strategy.</td>
</tr>
<tr>
<td>Failover Start</td>
<td>The backup is changing to active and starting in the state of the previously active controller.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Used for certain operations, such as download a strategy or installing firmware.</td>
</tr>
<tr>
<td>Non-Qualified Backup</td>
<td>The controller is attempting to become qualified (copying firmware, strategy, and chart state from the active controller). This state occurs frequently, and it can take a while to complete everything. This message may also indicate that the backup controller cannot communicate with the I/O.</td>
</tr>
<tr>
<td>Online (Candidate)</td>
<td>Controller has a strategy and may become active. Usually a very short state.</td>
</tr>
<tr>
<td>Online (non-candidate)</td>
<td>The controller has no strategy.</td>
</tr>
<tr>
<td>Powerup</td>
<td>A controller enters this state when it is first turned on.</td>
</tr>
<tr>
<td>Qualified Backup (Connected)</td>
<td>The controller is a qualified backup (ready to become active).</td>
</tr>
<tr>
<td>Qualified Backup (Disconnected)</td>
<td>The controller is a qualified backup but is not currently connected to the active controller.</td>
</tr>
<tr>
<td>Update Complete</td>
<td>Used when a controller is coming out of Maintenance mode with a strategy loaded and is attempting to become active. This is usually a very short state.</td>
</tr>
</tbody>
</table>

### Using the Memory Map to Read Status Messages

To see the status of a redundant controller in PAC Display, use the PAC Control command Read Number from I/O Unit Memory Map with the memory map address 0xF8000100. By frequently reading the value in an I/O unit’s memory map and putting it into a variable, you can display the status in PAC Display.

The value returned indicates the redundant controller’s status, as follows:

<table>
<thead>
<tr>
<th>State</th>
<th>Value (Decimal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Powerup</td>
<td>1</td>
</tr>
</tbody>
</table>
Using the Memory Map to Enter and Exit Maintenance Mode

To exit or enter maintenance mode programmatically in a PAC Control strategy, use the PAC Control command Write Number to I/O Unit Memory Map with the memory map address 0xF8001000. Use either a hexadecimal or ASCII value from the following table for the desired command.

<table>
<thead>
<tr>
<th>Command</th>
<th>Hexadecimal Value</th>
<th>ASCII Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Maintenance</td>
<td>0x4D</td>
<td>M</td>
</tr>
<tr>
<td>Exit Maintenance (become active)</td>
<td>0x4241</td>
<td>BA</td>
</tr>
<tr>
<td>Exit Maintenance (reset)</td>
<td>0x52</td>
<td>R</td>
</tr>
</tbody>
</table>

Entering Maintenance Mode on Boot

The memory map address 0xF8001004 reads/writes the Enter Maintenance Mode flag. Use the PAC Control command Read Number from I/O Unit Memory Map to read this memory location. If this flag is TRUE, on boot the controller will enter maintenance mode.

To set the Enter Maintenance Mode flag to TRUE, write the value 0x4D41494E (hex) or MAIN (ASCII) to memory map address 0xF8001004. The controller will enter maintenance mode on boot. If any other value is used, it won’t enter maintenance mode.

Redundant System State Machine

You can use the information below to better understand the PAC Redundancy Manager status messages and the sequence in which some system states occur. Messages appear in PAC Redundancy for each of the redundant controllers. For definitions of the status messages, see the previous section, “Redundant System Status Messages.”
Power cycle safety zone*

* When in this zone, the arbiter assumes that the controller may be active. If the arbiter loses communications with a (possibly) active controller, it must turn off power to that controller before telling the backup to become active. Otherwise you might have two simultaneous active controllers. Because turning off power to a device that is doing a flash write may cause corruption of data in flash memory, writes to flash memory (such as configuration writes, strategy updates, and firmware updates) are disabled.
Changing an IP Address on a Device

NOTE: This section details how to change an IP address on a system device, either a controller or the arbiter. To assign an IP address for the first time, see “Assigning an IP Address to the Arbiter” on page 21.

1. In PAC Redundancy Manager, under General Tools on the main window, click Change IP Address.
   The Change IP Address dialog box opens.

2. In the Current IP Address text box, enter the current IP address for the device.

3. Click Read Current Settings to see the Subnet Mask, Gateway, and DNS Address.

4. Enter a new IP address or other setting as needed, and then click Apply Settings.
5. Note the progress as the device is reset and tested. After you confirm the change, a message appears stating that the change was successful and that the device will restart. Restarting may take 10 to 20 seconds to complete. When the STAT LED shows solid green or solid orange when viewed from the top, the device is ready for use with its new address. Green means a strategy is running; orange means no strategy is running. Remember to write the IP address on the sticker or white area on the device.

Installing New Firmware

Each PAC controller and SNAP-PAC-SRA arbiter contains firmware, which is similar to an operating system. In the unlikely event that the firmware becomes damaged, or if a new version of the firmware is released, you can load new firmware to the controllers or arbiter using the PAC Redundancy Manager.

Installing Firmware to the Controllers

There are two different ways in PAC Redundancy Manager to install firmware to the controllers. The default and recommended method, Running System method, updates the firmware on a running system with as little disruption as possible. The other method, Controller, should not be used on a connected redundant system.

Using the Running System Method

1. Under Arbiter Management on the PAC Redundancy Manager, click Install Firmware. The Install Firmware window appears.

2. Check to make sure that Running System is selected in the top pane.

3. Under System Update, specify a strategy to be downloaded, in the form of a Controller Download File (CDF) in PAC Control. The CDF is required because a strategy is downloaded to the controller during the updating process. To generate a CDF file, open the strategy in PAC Control and select Compile > Compile Control Engine Download File. For more information, see form 1700, the PAC Control User’s Guide.

4. Under Firmware, browse to the firmware location and select the new firmware file.
5. Scroll down to the bottom of the screen and click Update Firmware. Progress of the upload appears at the bottom of the window. If an error occurs, notice the on-screen message.

Using the Controller Method

CAUTION: Do not use this method of installing firmware on a fully connected redundant system. It may be overwritten by the normal backup qualification process.

1. Turn off either the arbiter or the other controller.
2. Under Arbiter Management on the PAC Redundancy Manager, click Install Firmware.
3. On the Install Firmware window, select Controller.

4. Under Firmware, browse to the firmware location and select the new firmware file.

5. Scroll down to the bottom of the screen and click Update Firmware. Progress of the upload appears at the bottom of the window. If an error occurs, notice the on-screen message.

Installing Firmware to the Arbiter

NOTE: It is OK to install firmware to the arbiter while the system is running.
1. Under Arbiter Management on the PAC Redundancy Manager, click Install Firmware. The Install Firmware window appears.

   ![Install Firmware](image1)

   - Select the type of install:
     - Running system - updates the firmware on a running system with as little disruption as possible.
     - Controller - updates the firmware in a redundant controller.
     - Arbiter - updates the firmware in an arbiter.

2. Select Arbiter in the top pane.

   ![Arbiter Device](image2)

4. Under Firmware, browse to the firmware location and select the new firmware file.

   ![Firmware](image3)

5. Scroll down to the bottom of the screen and click Update Firmware.
Managing Memory

Controllers have various settings that can be configured, usually with PAC Manager, that are stored in RAM. You can use PAC Redundancy Manager to manage a redundant controller’s memory, such as storing and erasing strategies and configurations in flash memory or on a microSD card (for SNAP PAC controllers manufactured in November 2008 and later that have a microSD card slot in the top of the controller’s case).

Saving to flash protects a configuration from being lost if the controller is turned off. When you save to flash, the new configuration overwrites any configuration already in the flash memory.

**CAUTION:** Updating a redundant controller’s memory can disrupt a running system. During the update, the controller must be placed into Maintenance mode, during which time it cannot be the Active controller. If the controller is currently Active, the strategy will be stopped. If there is a qualified Backup controller, it will become Active.

The following options are available in PAC Redundancy Manager:

**Strategy Memory.** The following commands are available:

- **Store Strategy to Flash:** Saves the strategy to flash memory. Only one strategy at a time can be stored in flash memory.
- **Erase Strategy from Flash:** Erases the strategy currently stored in flash memory.
- **Erase Strategy from RAM:** Erases the strategy from RAM.

**Configuration Flash Memory.** The following commands are available:

- **Store Configuration to Flash:** Saves the configuration to flash memory.
- **Erase Configuration from Flash:** Erases the configuration stored in flash memory, which includes:
  - Clears error information in the status area (error code, transaction label, source address, error address).
  - Clears gains and offsets, counters (which are also deactivated),

Progress of the upload appears at the bottom of the window. If an error occurs, notice the onscreen message.
– latches, min/max data.
– Turns off digital outputs.
– Sets analog outputs to zero scale (0 counts).

- Reset Configuration to Defaults and Reset: Erases the configuration from flash memory (see above), restarts the controller, and resets points to defaults.

**microSD Card.** The following commands are available:

- Store Configuration to microSD card
- Erase Configuration from microSD card
- Erase Firmware from microSD card
- Erase Strategy microSD card
- Copy microSD card to Flash

*IMPORTANT: Before using the microSD card in your controller, make sure to read the section “Using the MicroSD Card” in chapter 3 of form 1592, the SNAP PAC S-Series User’s Guide.*

**To manage a strategy or configuration in memory:**

1. In PAC Redundancy Manager, under Tasks & Tools > Controller Management, click Manage Memory.
2. Under Controller, select the controller to manage.
3. Under Memory Commands, select a command.

**Controller**

Select the controller to manage:

- Controller 1 - updates Controller 1 of the currently selected system.
- Controller 2 - updates Controller 2 of the currently selected system.
- Other - use the given IP address.
4. Scroll down to the bottom of the screen, and click the button that displays the command you selected, such as Store Strategy to Flash.

Progress is displayed at the bottom of the screen.

Using Advanced Functions

*CAUTION: The advanced functions are for diagnostic and troubleshooting purposes. Misuse of these features can have unintended consequences. If you are unsure about how to use these features, please contact Opto 22 Product Support. See “Product Support” on page 5.*

A number of powerful advanced functions are provided which you can use to:

- Troubleshoot the system
- Use Maintenance mode to perform an operation not provided in PAC Redundancy Manager
- Have the arbiter reset a controller
- Directly control the power switch
To use the advanced functions:

2. Scroll down to the bottom of the screen and select Show Advanced Functions.

Two sets of advanced function commands appear, one for each controller:

3. Using the Advanced Functions window for the controller you want to manage, select one of the following options.
   
   A. Enter Maintenance: Stops any running strategy.

   NOTE: See also, “Using the Memory Map to Enter and Exit Maintenance Mode” on page 50.

   B. Exit Maintenance to Powerup state: Exits maintenance mode when there is no strategy loaded. For more information on maintenance mode, see D below.

   C. Exit Maintenance and become Active: Exits maintenance mode when there is a strategy loaded. For more information on maintenance mode, see D below.

   D. Enter Maintenance mode when booting: Causes the controller to enter Maintenance mode when the controller first boots. This is used during firmware uploads. It ensures that no backup qualification takes place. By going into maintenance mode, the controller sits idle and does not become active or backup; no firmware or strategy is automatically copied to it.

   E. Safe Reset: Performed only if the arbiter determines that system integrity can be maintained.

   F. Force Reset: Forces the arbiter to reset the controller.

   G. Hard Reset: Forces the arbiter to cycle the controller’s power.

   H. Redundant Power Switch State: Controls the redundant power switch. You can switch it on or off.
Using Controller Redundancy – Debug Options

With a control engine associated with your strategy and configured for redundant controllers (see “Step 2. Adding a Redundant Control Engine to a PAC Control Strategy” on page 36), PAC Control will automatically select which controller to use for downloading and debugging. While in this automatic mode, PAC Control downloads to the non-active controller whenever possible so that the active controller can keep running during the download.

In order to handle a variety of download and debug scenarios, PAC Control also provides other debug options.

To access the debug options:

1. Make sure you have turned on the redundancy options in PAC Control. For more information, see “Step 1. Enabling the PAC Control Redundancy Features” on page 33.

2. Right-click the control engine you configured previously for controller redundancy, and select Controller Redundancy – Debug Options to see the available options.

3. Choose one of the following settings.

   **Automatic Controller Selection:** This setting is selected by default because it is the least disruptive to your system. It should be used when you have connected and configured an arbiter and at least one controller. With this setting PAC Control will select which controller to use for downloading and debugging. If possible, it downloads to the non-active controller, so that the active controller can keep running during the download.

   **Use Controller 1 (or 2) with Arbiter:** Use this option when there is an arbiter connected and you want to download to or debug a specific controller during development or troubleshooting. Possible scenarios for using this option include demonstrating the control system, diagnosing a problem, network sniffing, and so on. When using this option, the arbiter manages the other controller by turning it off during the download.

   **Use Controller 1 (or 2) without Arbiter:** You can use this option when there is no arbiter connected and you want to download to or debug a specific controller during development or troubleshooting. In this case, you must make sure that the other controller is turned off. One possible use of this option is in a deployed system where the arbiter is not working.

   **CAUTION:** In order to avoid having two active controllers at the same time or unpredictable behavior from your system, make sure that the other controller is off.

   **Debug Backup Controller:** Use this option only if you want to debug the current qualified backup controller. No downloads are allowed.
Arbiter Status LEDs and Blink Codes

The following diagram shows the location of the arbiter’s status LEDs. See below for descriptions of the LEDs and the system blink codes.

### Communication Status LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>LNK</td>
<td>Link established with Ethernet network</td>
</tr>
<tr>
<td>ACT</td>
<td>Ethernet network activity</td>
</tr>
<tr>
<td>TX</td>
<td>Outgoing serial activity</td>
</tr>
<tr>
<td>RX</td>
<td>Incoming serial activity</td>
</tr>
</tbody>
</table>

### System Status LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| ARB |arbiter Status  
Off = arbiter has failed or is not powered  
Red = arbiter has failed  
Orange = arbiter is starting  
Green = arbiter is online|
| SYS |Controller Redundancy System Status  
Red = no controller is active  
Orange = one controller is active, with no qualified backup  
Green = one controller is active, with a qualified backup|
| CTR1 |Controller 1 Status  
Red = failed  
Orange-blinking = backup is qualified but cannot communicate with one or more configured I/O units, or not qualified  
Orange = backup qualified  
Green-blinking = becoming active, or active but cannot communicate with one or more configured I/O units  
Green = active nominal |
Resetting the Arbiter

1. Carefully insert a straightened paperclip or stiff wire into the small hole on the side of the arbiter.

2. Press and hold down the RESET button as described below.

<table>
<thead>
<tr>
<th>To perform this kind of reset...</th>
<th>...do this</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple restart</td>
<td>Press and immediately release the RESET button.</td>
<td>The arbiter restarts.</td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Turn off power to the arbiter and then turn it on again.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use PAC Manager to send the arbiter the “Restart from Powerup” command.</td>
<td></td>
</tr>
<tr>
<td>Restore factory default settings</td>
<td>Press and hold the RESET button for 1 or 2 seconds until the STAT LED turns solid green, and then immediately release the button. Don’t hold it down too long.</td>
<td>The arbiter restarts.</td>
</tr>
<tr>
<td></td>
<td>• The arbiter restarts.</td>
<td>• IP address is reset to 0.0.0.0 and subnet mask to 255.255.255.0.</td>
</tr>
</tbody>
</table>

CAUTION: Do not hold down the RESET button too long. If you hold it down longer than five seconds, the arbiter will enter hardware test mode, which is indicated by the STAT LED blinking orange, rapidly and continuously. Hardware test mode erases all files in RAM and flash memory and resets the IP address. If
your arbiter restarts in hardware test mode, cycle power; the result will be the same as restoring factory default settings (see table above).

If you hold down the RESET button less than five seconds but longer than the time needed to restore the default settings, the arbiter will restart in failsafe bootloader mode, which is indicated by the STAT LED blinking green 7 times quickly. This is a diagnostic mode that you don’t need to access unless you are troubleshooting a problem with Opto 22 Product Support. If your arbiter restarts in failsafe bootloader mode, cycle power; the result will be same as the simple restart described above.
RESETTiNG THE ARBITER